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Case Study: Additional Features
Design Intent
Stages in the Process
Create Feature Profiles and Axis system
Create Multi-profile Sketch Features
Create Wireframe Geometry
Create Shaft and Groove Features
Shell the Model

Additional Part Features
In this lesson you will learn how to create additional CATIA features.

Duration: Approximately 0.5 day

Lesson Contents:
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Case Study: Additional Features

The case study for this lesson is the Handle Block used in the Drill Press assembly shown 
below. The Handle Block is part of the Handle Mechanism sub-assembly. This case study 
focuses on creating features that incorporate the design intent of the part. The Handle 
Block will consist of shafts, grooves, multi-profiles, fillets, chamfers, and a shell feature.
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Design Intent (1/2)

XY plane

The Handle Block must meet the following 
design intent requirements:

� The top and the bottom portions of the 
model must be created as separate features. 

• The top portion of the model will be 
created as a shaft, the bottom section will 
be created as a multi-pad.

� The holes must be created at an angle to the 
XY plane.

• Create the holes on the shaft surface, 
aligned to a user-defined plane which is 
created at an angle to the XY plane. 
Creating the holes on a user-defined 
plane gives more flexibility in the hole 
placement as the angle of plane can be 
changed as required.
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Design Intent (2/2)

X-section of handle block

The Handle Block must meet the following 
design intent requirements (continued):

� The model must be hollow and must have a 
uniform thickness of 3mm, except the end, 
which must have a thickness of 1mm.

• The Shell option will hollow out the model 
as required. 

� The holes must be normal to the sides of the 
handle block.
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Stages in the Process

Use the following steps to create the handle block:

1. Create feature profiles.
2. Create multi-profile sketch features. 
3. Create reference geometry.
4. Create shaft and groove features.
5. Shell the model.
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Create Feature Profiles and Axis system
In this section you will learn about additional sketch tools.

Use the following steps:

1. Create feature profiles 
and Axis system. 

2. Create Multi-profile Sketch 
Feature

3. Create wireframe geometry.
4. Create shaft and groove 

features.
5. Shell the model.
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Additional Sketcher Tools 

Project 3D
elements

Re-limitation

Transformations

Axis Creation

Lesson 2 introduced you to the basic Sketcher 
tools and the Sketcher environment. This 
lesson will introduce you to the advanced 
Sketcher tools.
Sketcher includes the following additional tools:

� Axis creation tool
� Re-limitation tools
� Transformation tools
� Project 3D element tools
� Analyze a sketch using the Sketch Analysis

tool.

In addition, you will learn how to:

� Create Equivalent dimensions
� Create Formula

Formula creation Equivalent dimension creation

Sketch Analysis
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Sketcher Re-limitation Tools 

A

B

C

D

E

The Re-limitation tools trim or extend the existing 
sketched geometry. They can be found in the Re-
limitation toolbar, which is a flyout menu in the 
Operation toolbar.

Available re-limitation tools include the following:

A. Trim

B. Break

C. Quick Trim

D. Close

E. Complementary Angle
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Re-limitations

Creates the complementary arc.

Closes the selected arc.

Trims an intersected element.

Breaks a curve at a selected point.

Trims two curves. Keeps the part of the 
curves you selected. This option can 
also be used to extend to elements.

Complement

Close

Quick Trim

Break

Trim

Tool Geometry Description
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Trim Options 
Before

First 
Element

Second 
Element

B A

Once the Trim tool is selected, the Sketch Tools 
toolbar expands to display two modes for trim:

A. The Trim All Elements mode trims both the 
selected elements.

B. The Trim First Element mode trims only the 
first selected element; the second element is 
left unchanged.
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Quick Trim Options
Before

A

B

C

Once the Quick Trim tool is selected, the 
Sketch Tools toolbar expands to display 
several modes for quick trim:

A. The Break and Rubber In mode removes a 
selected portion of an element up to its 
intersection with other elements.

B. The Break and Rubber Out mode keeps the 
selected portion of an element up to its 
intersection with other elements.

C. The Break and Keep mode keeps the entire 
elements but breaks the element at the 
intersection with other elements.



Student Notes:

CATIA V5 Fundamentals- Lesson 4: Additional Part Features
����������	��

Copyright DASSAULT SYSTEMES 4-12

C
op

yr
ig

ht
 D

A
S

S
A

U
LT

 S
Y

S
TE

M
E

S

Sketcher Transformation Tools 

A

B

C

D

E

F

Transformation tools are used to modify 
existing sketcher geometry. They can also be 
used to create a duplicate of the existing 
sketcher geometry. 

Transformation tools are found in the 
Transformation toolbar, which is a flyout 
menu in the Operation toolbar. Available 
Transformation tools include the following:

A. Mirror
B. Symmetry
C. Translate
D. Rotate
E. Scale
F. Offset
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Mirror and Symmetry Options

2a 2b
1

3

Both options, Mirror and Symmetry, allow 
you to mirror the selected geometry about 
an axis. The Mirror option retains the 
original geometry, while the Symmetry 
option removes it.

Use the following steps to use the Mirror 
and Symmetry tools:

1. Select the geometry to mirror. 
Use the <Ctrl> key to select multiple 
items.

2. Select the tool.
a. Mirror
b. Symmetry

3. Select the symmetry axis.

Result of Mirror Result of Symmetry
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Translation (1/2)

1

2

3

4

5

The Translation tool moves the selected 
geometry along a translation vector. 

Use the following steps to translate geometry:

1. Select the entities to move.
2. Select the Translate tool.
3. Select the Duplication mode option. 

� When the Duplication mode option is 
selected, the original geometry is 
unchanged and a copy of the 
geometry is created in the new 
location. You can also create multiple 
instances which are equidistant to 
each other. In this example, two 
instances are created.

4. If in the duplicate mode, specify the 
constraint conditions. 

� You may choose to keep all internal 
constraints, and/or all external 
constraints.

5. Select a point on the screen to act as the 
start point.
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Translation (2/2)

7

6

Use the following steps to translate geometry 
(continued):

6. Optionally, enter a distance value in the 
length field and click OK.

7. Move the start point on the screen. If no 
distance has been specified (step 6), 
you can place the selected elements 
anywhere. If a distance has been 
applied and OK is selected, you will 
have to define the direction.

8. Click to place the geometry.

8
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Rotation (1/2)
1

2

3

4

5

The Rotate tool lets you rotate selected 
sketched element(s) about a point.

Use the following steps to rotate geometry:

1. Select the entities to rotate.
2. Select the Rotate tool.
3. Select the Duplication mode option. 

� When the Duplication mode option is 
selected, the original geometry is 
unchanged and a copy of the geometry is 
created in the new location. You may  
create multiple instances which are 
equidistant to each other. In this example, 
one instance is created.

4. If in duplicate mode, specify Constraint 
Conservation. If selected, all internal 
constraints will be maintained.

5. Select a point on the screen to act as the 
center of rotation.
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Rotation (2/2)

6

7

8

Use the following steps to rotate geometry 
(continued):

6. Select a point on the screen to define a 
reference line for the angle.

7. Specify a value in the Angle field or move 
the mouse to rotate the elements.

8. Click OK or click on the screen to complete 
the rotation.
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Scale (1/2)

1

2

3

4

The Scale tool allows you to resize the 
selected sketched element(s). 

Use the following steps to scale sketched 
element(s):

1. Select the entities to scale.
2. Select the Scale tool.
3. Select the Duplication mode option. 

� When the Duplication mode option is 
selected, the original geometry is 
unchanged and a copy of the geometry is 
created in the new location.

4. If in duplicate mode, specify Conservation 
of the constraints. If selected, all the 
constraints will be maintained, but they will 
be converted into reference dimensions.
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Scale (2/2)

5

6

7

Use the following steps to scale sketched 
element(s) (continued):

5. Select a point on the screen to act as the 
center point for scaling.

6. Specify a value in the Scale field or move 
the mouse to scale the elements.

7. Click OK or click on the screen to complete 
the scaling.
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Offset Propagation Modes

C

B

AThe Offset tool lets you offset one or more 
sketched elements. Once the Offset tool is 
selected, three propagation modes become 
available from the Sketch Tools toolbar:

A. In No Propagation mode, only the selected 
element(s) is offset.

B. In Tangent Propagation mode, the selected 
element(s) and all elements tangent to it 
are offset.

C. In Point Propagation mode, the selected 
element(s) and all elements that form a 
chain with it are offset.
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Offset (1/2)

1

2

3 4

5

Use the following steps to offset sketched 
element(s):

1. Select the sketched element(s) to offset.
2. Click the Offset icon.
3. Select the Propagation mode.
4. Click the Both sides icon if you want to 

offset the element on both sides.
5. Enter the number of instances. Each 

instance will be equi-distant from each 
other. In this example, two instances are 
created.
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Offset (2/2)

6

8

7

Use the following steps to offset sketched 
element(s) (continued):

6. Move your pointer to the side on which 
you want to create the offset.

7. Press the <Tab> key until the Offset field 
is highlighted. Specify the offset distance. 

8. Press the <Enter> key to place the offset.



Student Notes:

CATIA V5 Fundamentals- Lesson 4: Additional Part Features
����������	��

Copyright DASSAULT SYSTEMES 4-23

C
op

yr
ig

ht
 D

A
S

S
A

U
LT

 S
Y

S
TE

M
E

S

Project 3D Elements 

A

B

C

Several tools are available to project the 
existing 3D elements onto the sketch plane. 
These projected elements can be used as a 
standard sketch geometry, or converted into a 
construction geometry. 

3D projection tools are found in the 3D 
Geometry toolbar, which is a fly-out menu in 
the Operation toolbar. Available projection 
tools include the following:

A. Project 3D Elements

B. Intersect 3D Elements

C. Project 3D Silhouette Edges
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3D Geometry Elements 

1 2 3

1 2 3

1 2 3

Project the silhouette of a 
cylindrical element onto the 
sketch plane. The axis of 
revolution for the projected 
element must be parallel to the 
sketch plane.

Intersect 3D elements with the 
sketch plane. 

Project 3D elements onto the 
sketch plane.

DescriptionGeometryTool

Project 3D 
Elements

Intersect 
3D 
Elements

Project 3D 
Silhouette 
Edges
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Isolate Projected Elements 

By default, projected elements are linked to the 3D 
geometry from which they were created. 

You can break this link by right-clicking on the 
projected element and clicking Mark.x object > 
Isolate from the contextual menu. Once the 
element is isolated, it will no longer be associative 
with the 3D geometry from which it was projected. 
This means that modifications to the 3D geometry 
will not impact the sketched elements created from 
it. 

Once isolated, the projected geometry converts 
into standard sketched elements (e.g., lines, 
points, arcs).
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Sketch Analysis

The Sketch analysis tool can be used to help 
resolve problems with the sketch. 

This tool can be used to determine a sketch’s 
constraint status (i.e., Under-constrained, Iso-
constrained, Over-constrained, or Inconsistent), 
and where degrees of freedom still exist in the 
sketch. 

The Sketch Analysis tool can also be used to 
determine whether a profile is open or closed. 
This is useful if you receive an error while trying 
to create sketched-based features.
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Sketch Analysis Window (1/3)

A

B

C

a b c d e

The sketch analysis window has three tabs. 
Each tab contains information to analyze the 
sketch.

The Geometry tab is used to determine 
whether the sketch geometry is valid or not:

A. The General Status area analyzes 
several elements in the context of the 
entire sketch.

B. The Detailed Information area provides 
the status and comment on each 
geometric element in the sketch.

C. The Corrective Actions area lets you 
correct geometry. You can:

a. Convert an element into a 
construction element.

b. Close an open profile.
c. Erase unwanted geometry.
d. Hide all the constraints.
e. Hide all the construction 

geometries.
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Sketch Analysis Window (2/3)

A

B

a b c d e f

The Projections/Intersections tab is used 
to determine the status of all the projected 
elements:

A. The Detailed Information area provides a 
the status and comment on each 
projected or intersected element in the 
sketch.

B. The Corrective Action area lets you 
correct geometry. You can:

a. Isolate geometry.
b. Activate or Deactivate a constraint.
c. Erase geometry.
d. Replace a 3D geometry.
e. Hide all the constraints.
f. Hide all the construction 

geometries.
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Sketch Analysis Window (3/3)

A

B

C

a b

The Diagnostics tab displays a full diagnosis 
of all the sketched geometries. It provides an 
analysis of the sketch as well as information 
on individual geometrical elements:

A. The Solving Status area provides an 
overall analysis of the sketched 
geometry.

B. The Detailed Information area provides a 
description and status on each constraint 
and geometric element in the sketch. 

C. The Action area enables you to:
a. Hide all constraints.
b. Hide all the construction 

geometries.
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Performing a Quick Geometry Diagnosis (1/2)

2

3

1

Use the following steps to analyze a sketch:

1. Click the Sketch Solving Status icon.
2. The Sketch Solving Status dialog box 

appears. It indicates the overall status of 
the Sketch Geometry. In this case, the 
sketch is under-constrained even though 
the sketch appears to be green (iso-
constrained). 

3. Under- and over-constrained geometrical 
elements are highlighted on the sketch 
and in the specification tree.
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Performing a Quick Geometry Diagnosis (2/2)

4

5

6

Use the following steps to analyze a sketch 
(continued):

4. Click the Sketch Analysis icon in the 
window or in the toolbar.

5. The Sketch Analysis window appears. In 
this example, the profile needs to be closed 
and the point needs to be changed to a 
construction element.

6. Click Close to close the Sketch Analysis 
window.
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Create Relationships between Dimensions

The Equivalent Dimensions feature can be used 
to define an equality between a set of Angles or 
Length parameters. 

The formula can be used to relate one parameter 
to another.

Highlighted dimensions are Equivalent Dimensions

Relationships between Dimensions can be 
created by using-

a. Equivalent Dimensions
b. Formula

Highlighted dimension is driven by a formula
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Equivalent Dimensions

Equivalent Dimensions feature help to-
a. Increase designers’ productivity.
b. Reduce the model size.

The Equivalent Dimensions feature can be 
found in the Knowledge toolbar, which can be 
accessed in any workbench (such as Sketcher, 
Part Design) . 

The value of Length or Angle can be modified 
through the editor and is propagated to all the 
parameters belonging to the equivalence.
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Creating Equivalent Dimensions

Use the following steps to create Equivalent 
Dimensions through a sketcher:

1. Edit the sketch to enter the Sketcher 
Workbench.

2. Select the dimensions that you want to 
equalize and click Equivalent 
Dimensions icon.

3. Equivalent Dimension edition dialog box 
is displayed.
a. Click Edit List to add/remove 

parameters for equivalent dimensions.
b. A dialog box is displayed for you to 

select the equivalent parameters. 
c. Use arrows to add/remove parameters 

for equivalent dimensions.
d. Click OK to go back to Equivalent 

Dimension edition dialog box.
e. In Equivalent Dimension edition dialog 

box, specify the value of equality.

2

2

3 3a

3b

3c

3e

3d
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Editing Equivalent Dimensions through Feature Tree

1. The Equivalent dimension feature is 
displayed in the Relations node of the 
feature tree. 

a. Double-click on it to view the list of 
parameters, modify it or change the 
value.

b. Double-click on Value to change the 
value of equality.

1

1b

2. Any dimension in the list of equivalent 
dimensions can be selected graphically and 
edited in order to modify all the dimensions. 
The big advantage is that there is no unique 
driving dimension.

a. Double-click the value: the dialog box 
displays an icon next to the value which 
shows that this is an equivalent 
dimension. The value can be modified in 
the same way as you modify a standard 
constraint

2
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Formula

1

2

1. Using the formula window.
2. Editing the dimension value with the 

contextual menu.

A formula is used to relate one parameter 
to another. It can be created by:
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Creating a Formula

Use the following steps to create a formula 
through a sketcher:

1. Edit the sketch to enter the Sketcher 
Workbench.

2. Double-click the dimension to which you 
want to associate a formula. 

3. From Contextual menu in the value field 
select Edit Formula.

4. In the Formula Editor dialog box, add a 
relation.

5. Symbol f(x) appears in front of a dimension 
to which the formula is associated.

1

2 3

4

5
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Editing Formula through Feature Tree

1. The Formula feature is displayed in the 
Relations node of the feature tree. 
a. Double-click it to view the relation and 

to modify it.
b. The highlighted value is a driving 

dimension. 

1

1b
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Create an Axis System

A local axis is a user-defined axis system that can be used to define local coordinates. For example, it is 
often easier to build a point by coordinates, with respect to a local axis rather than creating it in the 
absolute coordinates system. An axis system can automatically be generated when a new part is created. 
This axis system is defined at the origin of the model and uses the default reference planes for direction.

Local Axis System
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Types of Axis System

1. Standard Axis System: is defined by a origin 
and three orthogonal directions.

2. Rotation Axis System: is defined by an origin, 
three orthogonal directions, and an angle 
based on a selected reference.

3. Euler Axis System: is defined using Euler 
angles to specify its orientation.

The following types of local axis systems can be 
defined:

1

3
2
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Creating an Axis System

1. Click the Axis System icon.
2. Select the pad vertex as origin point.
3. To define an axis direction, click on the 

appropriate axis field and select an element to 
define direction. For example, to define the 
direction of the X axis, click on the X axis field 
and select the element to define the direction. 

4. Click on a second axis field and define its 
direction. The direction of the third axis will 
automatically be defined based on the previous 
selections.

5. Select the Reverse option to reverse the axis 
direction, if necessary. In this example, the X 
axis is reversed.

6. Click OK to create the axis.

Use the following steps to create a local standard 
axis system:

1

2

5

6

3

4
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Axis System: Set as Current

By default, the last created axis system becomes 
the active system. The current axis system is 
highlighted in the specification tree, and is 
displayed with solid lines on the model. All the 
other axis systems are dashed lines on the model. 

To change the active axis system, right-click on the 
system to be made current and click Axis 
System.x object > Set as Current.
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Axis System with New Part 

An axis system can automatically be generated when a new part is created. This axis 
system is defined at the origin of the model and uses the default reference planes for 
direction. If this option needs to be changed, click Tools > Options > Infrastructure
> Part Infrastructure. Then from the Part Document tab, select the Create an Axis 
System when creating a new part option.
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Create Multi-profile Sketch Features
In this section, you will learn how to create several features using one sketch.

Use the following steps:

1. Create feature profiles and 
Axis system. 

2. Create Multi-profile 
Sketch Feature

3. Create wireframe geometry.
4. Create shaft and groove 

features.
5. Shell the model.
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Multiple Profiles
Sketch

A B

Multi-profile sketches are sketches that contain 
more than one closed profile. This helps to 
quickly create multiple features using only one 
sketch. Therefore, if the sketch is removed, the 
corresponding features are also removed. This 
method is not recommended if the sketched 
profiles are complicated because editing all the 
individual profiles can be difficult when they are 
within one sketch.

So far, you have used multi-profile sketches to 
create multiple pockets using a single pocket 
feature. Multi-profile sketches can also be used 
to create the following:

A. Multi-pads/pockets
B. Sub-elements of a Sketch
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Multi-Pads/Pockets (1/2)

6

3

4

5

2

1

Multi-pads and pockets are features that create 
several pads/pockets in one operation. These 
tools require a sketch with at least two closed 
profiles that do not intersect. Consider using 
these tools as a fast way to create multiple 
features.

Use the following steps to create a multi-pad:
1. Create a sketch containing at least two 

closed profiles.
2. Select the sketch and click the Multi-pad

or Multi-Pocket icon. In this example, 
Multi-Pad is selected.

3. Select the first extrusion domain. Specify a 
depth value for the closed profile.

4. Repeat step 3 for each extrusion domain.
5. Click OK to create the Multi-pad.
6. The Multi-pad feature is created in the 

specification tree.
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Multi-Pads/Pockets (2/2)

1

3

2

5

Like standard pads and pockets, multi-
pad/pockets can be extruded in two directions. 

Use the following steps to extrude the multi-
pad in a second direction:

1. Select More>>.
2. Select extrusion domain. In this example, 

Extrusion domain.5 is extruded in two 
directions. 

3. Specify the second depth for the profile. 
4. Repeat step 2 for each extrusion domain. 

In this example, only Extrusion domain.5 is 
extruded in two directions.

5. Click OK to complete the feature.

Conf. Dep.
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Solving Ambiguity for Multi-Pads/Pockets

Careful thought should be given to the profiles created in the sketch when they are used 
to define a Multi-Pad/Pocket. The profiles cannot intersect, they must form a closed loop 
to avoid feature definition error. Use the Break tool in the Sketcher workbench to create 
proper profiles if necessary. 

For example, two profiles are created as shown within the same sketch. If the shared line 
between the two profiles is created as one geometric element, the multi-feature fails. The 
top profile does not form a closed loop. By breaking the shared line into two separate 
segments, the top profile is now closed.
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Sub-Elements of a Sketch (1/2)

2

1

3

In some cases, you may need to create a 
feature that uses only one profile of a multi-
profile sketch. This is done using the Sub-
Elements option. This tool allows you to 
extract only the profile you need from the 
sketch. Deleting or modifying the sketch will 
affect all features associated with it, because 
several features can be based on the same 
sketch. 

Follow these steps to use a sub-element of a 
sketch:

1. Access the feature creation window (in this 
example, a Pad feature). Do not select the 
sketch before selecting the icon.

2. Right-click the Profile Selection field and 
select Go to Profile Definition.

3. Select Sub-elements radio button.

Conf. Dep.
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Sub-Elements of a Sketch (2/2)

4

5

6

7

Follow these steps to use a sub-element 
of a sketch (continued):

4. Select an element on the required profile. 
All the entities that are part of the same 
loop as the selected geometry will get 
highlighted.

5. Click OK to return to the Pad Definition 
dialog box.

6. The Profile Selection field now says gets 
updated to  “Complex”. 

7. Click OK to complete the feature.
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Solving Ambiguity for Sub-Elements (1/2)

1

2

4

3

If you select a multi-profile sketch before 
selecting the feature tool, an error appears, 
indicating profile ambiguity. This is because 
multiple profiles are contained within the sketch 
and CATIA is unsure how to create the feature. 

Use the following steps to solve the error:

1. Select Yes on the error window.
2. Right-click the Profile field and click Go to 

Profile definition.
3. Select the geometry in the selection window 
4. Click the Remove button.

Conf. Dep.
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Solving Ambiguity for Sub-Elements (2/2)

6

5
7

Use the following steps to solve the error 
(continued):

5. Click the Add button.
6. Add the correct profile.
7. Click OK to return to the feature definition 

window.
8. Complete the definition and click OK.
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Exercise: Multiple Profile Sketch Features
Recap Exercise

15 min

In this exercise you will create a multi-pad feature and two pocket 
features using only sub-elements of a sketch. You will use some of the 
additional sketcher tools you have learned in this lesson to complete 
the exercise. Detailed instructions for this exercise are provided.

By the end of this exercise you will be able to:

� Create a multi-profile sketch

� Create a multi-pad feature

� Create a pocket using a sub-element of a sketch

� Use the Re-limitation, Projection, and 
Transformation tools in the Sketcher workbench
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Do it Yourself (1/16) 

1e

1d

2c

1. Create a new part. 
� Create a new part named Ex4A.CATPart.

a. Click File > New.
b. Select Part.
c. Click OK.
d. Type [Ex4A] as the part name.
e. Click OK.

2. Create a multi-profile sketch. 
� Create a sketch that contains more than one 

closed profile. You will use this sketch to 
create a Multi-pad in a later step.

a. Select the YZ plane.
b. Click the Sketcher icon.
c. Create the rectangle as shown. Make it 

symmetric about the ZX plane.
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Do it Yourself (2/16) 

2d

2e

2. Create a multi-profile sketch (continued...). 

d. Create a profile as shown. The profile 
contains two lines and a tangent arc. 
Ensure that the lines are coincident with 
the top line of the rectangle and 
symmetric about the ZX plane. Make the 
center of the arc coincident with the ZX 
plane.

e. Create a circle whose centre is 
coincident with the centre of the arc.
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Do it Yourself (3/16) 

2f

2. Create a multi-profile sketch (continued...). 

f. Dimension the sketch as shown.
g. Exit the Sketcher.
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Do it Yourself (4/16) 

3c

3b

4b

3. Create a multi-pad feature.
� Create a multi-pad feature using the 

sketch created in the last step.
a. Select the sketch.
b. Click the Multi-Pad icon.
c. Read the error and click OK.
d. The error indicates that the sketch 

is not valid. Can you guess what is 
the problem?

e. Cancel the multi-pad creation by 
selecting the Multi-Pad icon again.

4. Correct the sketch.
� The sketch is not valid because the 

top line of the rectangle is one piece 
and needs to be shared by two 
profiles. It is not possible to create 
the top profile using this sketch as it 
is.

a. Double-click on the sketch to edit.
b. Click the Break icon.
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Do it Yourself (5/16) 

4c

4d

4f

4g

4e

4. Correct sketch (continued...).

c. Select the top line of the rectangle 
as the line to break.

d. Select one of the angled lines as 
the breaking element.

e. Click the Break icon again.
f. Select the top line of the rectangle 

near the other angled line.
g. Select the other angled line as the 

breaking element.
h. The line now consists of three 

separate entities. The top profile 
can now be constructed.

i. Exit the Sketcher workbench.
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Do it Yourself (6/16) 

5b

5c

5d

5. Create multi-pad.
� Now that the sketch is correct. Create 

the multi-pad feature.
a. Select the sketch.
b. Click the Multi-Pad icon.
c. Select the first domain. The circle 

highlights on the model.
d. Specify a depth of [20mm].
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Do it Yourself (7/16) 

5e

5f

5. Create multi-pad (continued...).

e. Select the next profile in the dialog box. The top profile is highlighted on the screen.
f. Specify a depth of [10mm].
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Do it Yourself (8/16) 

5g

5h

5i

6a

5. Create multi-pad (continued...).

g. Select the final profile in the dialog 
box. The rectangular profile is 
highlighted.

h. Specify a depth of [20mm].
i. Click OK to complete the feature.

6. Create a multi-profile sketch.
� Create a multi-profile sketch that will be 

used to create separate pocket 
features.

a. Select the top face of the rectangle 
and access the Sketcher workbench.
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Do it Yourself (9/16) 

6b

6c

6d

6e

6e

6. Create a multi-profile sketch 
(continued...).

b. Create an elongated hole as shown.
c. Select the 3D geometry edge as 

shown.
d. Click the Offset icon.
e. Move the pointer towards the center 

of the model. This indicates the 
direction of the offset.

f. Press the <Tab> key several times 
until the Offset field is highlighted in 
the Sketch Tools toolbar. Specify an 
offset of [5mm].
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Do it Yourself (10/16) 

6g 6h

6i

6. Create a multi-profile sketch 
(continued...).

g. Press the <Enter> key to create the 
offset geometry. Notice that the offset 
line is yellow. This indicates that it is 
projected from the 3D geometry.

h. Offset the other edges of the 3D 
geometry as shown.

i. Offset the edge of the circular pad 
[3mm].
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Do it Yourself (11/16) 
6j

6k

6l

6m

6. Create a multi-profile sketch 
(continued...).

j. Click the Trim icon.
k. Click Trim All Elements from the 

Sketch tools toolbar.
l. Select the first edge in the area to be 

kept.
m.Select the second edge in the area to 

be kept. The entities are trimmed.
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Do it Yourself (12/16) 

6n

6o

6. Create a multi-profile sketch 
(continued...).

n. Repeat the trim for the other 
elements.

o. Create a circle that is concentric with 
the circular pad. 

p. Exit the Sketcher workbench.
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Do it Yourself (13/16) 

7b

7d

7e

7f

7. Create pockets.
� Use the sketch created in the last step 

to create two pocket features that cut 
through all the material. The third 
profile will be used in a separate 
feature.

a. Select the sketch created in step 6.
b. Click the Pocket icon.
c. All the profiles are highlighted. In this 

exercise, two of the profiles should 
have different depths than the third.

d. Right-click on the Profile Selection 
field and click Go to Profile.

e. Select Sketch.2 in the dialog box.
f. Select Remove.

Conf. Dep.
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Do it Yourself (14/16) 

7g

7h

7i

7j

7k

7l

7. Create pockets (continued...).

g. Click Add.
h. Select the elongated hole profile.
i. Select the circle profile.
j. Click OK.
k. Select a depth of Up to Last.
l. Click OK.
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Do it Yourself (15/16) 

8c

8d

8h

8. Create pocket.
� Use the sketch created in step 6 to 

create the final pocket feature.
a. Show Sketch.2 but do not select it.
b. Click the Pocket icon. 
c. Right-click on the Profile Selection 

field and click Go to Profile 
definition.

d. Select the center profile.
e. Click OK to the Profile Definition 

dialog box.

Conf. Dep.
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Do it Yourself (16/16) 

8g

8f

8h

8i

8. Create pocket (continued...).

f. Select a depth of Up To Surface. 
g. Select the surface shown.
h. Specify an offset of [5mm].
i. Click OK.
j. Hide Sketch.2 again.

9. Save and close the file.
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Exercise Recap: Multiple Profile Sketch Features

� Create a multi-profile sketch

� Create a multi-pad

� Create pockets using sub-elements 
of a sketch

� Use re-limitation and transformation 
tools in the Sketcher workbench
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Exercise: Sketch Analysis and Pocket
Recap Exercise

15 min

By the end of this exercise you will be able to:

� Problem-solve a sketch

� Use the Sketch Analysis tool

� Create a pad using a sub-element of a sketch

� Create a multi-pocket

In this exercise, you will open an existing part that contains a multi-profile sketch. You will 
use this sketch to create several features. High-level instructions for this exercise are 
provided.
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Do it Yourself (1/7) 

3

1. Open Ex4B.CATPart. 
� Open an existing part file.

2. Create multi-pad feature.
� Create the multi-pad feature using the 

sketch given. An error message 
appears, indicating that the sketch is 
not valid. Cancel the multi-pad creation. 

3. Edit the sketch.
� Access the Sketcher workbench for 

Sketch.1 to investigate the sketch.

1

2
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Do it Yourself (2/7) 

4

5

4. Use the Sketch Solving Status Tool.
� Use the Sketch Analysis tool to 

investigate what is wrong with the sketch. 
Although the sketch appears to be 
completely green (Iso-constrained), the 
status of the sketch is actually under-
constrained. Observe the highlighted 
points.

5. Access the Sketch Analysis tool.
� Use the Sketch Analysis tool to further 

investigate the sketch.
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Do it Yourself (3/7) 

8

6

7

6. Review the geometry.
� Select the Geometry tab. The sketch 

contains two open profiles and an 
isolated line.

7. Remove the constraints from the 
display.
� To simplify the display, select the Hide 

Constraints icon.

8. Resolve the open profile.
� Select the inside open profile and use 

the Close Opened Profile icon to 
resolve the issue.
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Do it Yourself (4/7) 

9

9. Resolve the isolated line.
� Select the isolated line in the window. Observe 

where it is located in the model. This line should 
be a construction element. Use the Set in 
Construction Mode icon to convert the point.



Student Notes:

CATIA V5 Fundamentals- Lesson 4: Additional Part Features
����������	��

Copyright DASSAULT SYSTEMES 4-76

C
op

yr
ig

ht
 D

A
S

S
A

U
LT

 S
Y

S
TE

M
E

S

Do it Yourself (5/7) 

10

10. Review the second open profile.
� Select the outer open profile from the 

window. Observe the area as shown. 
Zoom in; observe that the line is not a 
single entity but two entities. This is 
not correct. The Close Opened 
Profile option could be used to 
resolve this issue; however, the line 
would still be two separate entities. 
Instead, exit the Sketch analysis tool 
and resolve the issue using re-
limitation tools.
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Do it Yourself (6/7) 

11

12

11. Resolve the second open profile.
� Delete one of the top lines. Use the 

Trim tool to extend the remaining line. 
Remember to add tangency between 
the line and the arc.

12. Re-analyze the sketch.
� Return to the Sketch solving status 

window. The sketch should now be 
iso-constrained.



Student Notes:

CATIA V5 Fundamentals- Lesson 4: Additional Part Features
����������	��

Copyright DASSAULT SYSTEMES 4-78

C
op

yr
ig

ht
 D

A
S

S
A

U
LT

 S
Y

S
TE

M
E

S

Do it Yourself (7/7) 

13

13. Exit the sketcher and create the multi-
pad feature as shown.

14. Save and close the file.

Conf. Dep.

Conf. Dep.
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Exercise Recap: Sketch Analysis and Pocket

� Problem-solve a sketch

� Use the Sketch Analysis tool

� Use re-limitation tools

� Create a multi-pad feature
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Exercise: Multiple Profile Sketch Features
Recap Exercise

15 min

In this exercise, you will create a part that contains two features, a multi-
pad, and a multi-pocket. You will use the tools learned in this lesson to 
complete the exercise with no detailed instructions. 

By the end of this exercise you will be able to:

� Create a multi-pad

� Create a multi-pocket
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Do it Yourself (1/2)

1

2

1. Multi-pad
2. Multi-pocket

You need to create the following features:
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Do it Yourself (2/2)

1. Create the following part.
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Exercise Recap: Multiple Profile Sketch Features

� Create a multi-pad

� Create a multi-pocket
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Create Basic Wireframe Geometry
In this section, you will learn how to create wireframe elements (i.e., points, lines, and 
planes).

Use the following steps:

1. Create feature profiles and 
Axis system. 

2. Create Multi-profile Sketch 
Feature

3. Create basic wireframe 
geometry.

4. Create shaft and groove 
features.

5. Shell the model.
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Reference Geometry

In the Part Design workbench, you have the 
ability to create points, lines, and planes 
outside of the Sketcher environment. These 
elements are called reference (or 3D 
wireframe) geometry.

Depending on how the part was initially 
created, these elements can be represented 
in the specification tree in two ways. If the 
Enable hybrid design option is selected, 
CATIA will place these features within the 
main PartBody. If the Enable hybrid design
option is cleared, wireframe elements are 
inserted under a group called a Geometrical 
set. Geometrical sets contain only 3D 
wireframe and surface elements and not 
solid geometry.



Student Notes:

CATIA V5 Fundamentals- Lesson 4: Additional Part Features
����������	��

Copyright DASSAULT SYSTEMES 4-86

C
op

yr
ig

ht
 D

A
S

S
A

U
LT

 S
Y

S
TE

M
E

S

Accessing the Reference Elements Toolbar

The toolbar is located at the bottom of the 
toolbars on the right-hand side of the 
screen. You may need to move other 
toolbars to view it.

If you cannot locate the toolbar, it may be 
turned off. To turn on the toolbar, click View 
> Toolbars > Reference Elements 
(Extended).
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Power Input Line

Instead of selecting the icons, you can use 
the power input line to access the 3D 
wireframe tools.

Type:
• [c:plane] to create a plane
• [c:point] to create a point
• [c:line] to create a line

The command can be used for many tools. 
It is a good way to launch functions when 
you cannot find the icon. To view the 
command, hover the mouse pointer over the 
icon.

For example, placing the pointer over the 
Line icon displays c:Line beside the power 
input line.
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Points

1

2

3

4

5

Points are used to mark a location on a model. 
They can be used as a basis for creating 
additional features. Use the following steps to 
create a point:

1. Click the Point icon.
2. Select the Point Type from the menu.

• Many types of points can be created. The 
required fields vary depending on the selected 
type. In this example, you create a 
Coordinates point type.

3. Specify values as required. For a coordinate 
point, the X, Y, and Z distances from the 
reference point are required.

4. Click OK to create the point.
5. The point is added to the specification tree 

under the Geometrical set.
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Lines (1/2)
1

2

3

Lines are created for many purposes, they 
can be used to define the direction for 
additional geometry (solid and wireframe), or 
as an axis for a revolved feature. 

Use the following steps to create a line:

1. Click the Line icon.
2. Select the Line Type from the menu.

• Many types of lines can be created. 
The required fields vary depending on 
the selected type. In this example, you 
create a Point-Point type line.

3. Specify values as required. For a Point-
Point line, two points are required.
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Lines (2/2)

4

Use the following steps to create a line 
(continued):

4. Click OK to create the line. The line is 
added to the specification tree under the 
Geometrical set.
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Planes (1/2)

2

3

1Planes are used to create a planar 
reference in a specific location. In the Part 
Design workbench, they are used as sketch 
supports. 

Use the following steps to create a plane:

1. Select the Plane icon.
2. Select the Plane Type from the menu.

• Many types of planes can be created. 
The required fields vary depending on 
the selected type. In this example, you 
will use the Offset from plane type.

3. Specify the values as required. For an 
Offset from plane type, a planar surface 
or an existing reference plane is 
required.
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Planes (2/2)

4

5

Use the following steps to create a plane 
(continued…):

4. Click OK to create the plane.
5. The plane is added to the specification tree 

under the Geometrical Set.
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Recommendations for Reference Elements
In this section, you will be given a recommendation to help during the creation of 
reference elements.
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No Reference Elements on Solid Face (1/3)

During the design and development of a 
part:

a. The solid face or edge is subject to 
change and can disappear. 

b. A planar face can later become a 
non-planar face.

c. Dress-up features can be removed for 
a downstream manufacturing 
processes.

It is recommended not to create 
reference elements that rely on solid 
faces, edges or dress-up features.

Plane relies on 
face and edge.

Plane will be affected 
if edge/face 
disappears

Plane relies on 
dress-up feature.

Plane will be affected 
if dress-up feature is 
removed
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No Reference Elements on Solid Face (2/3)

1. Plane.1 relies on solid face. 
2. During further design and 

development of the part, the profile 
is changed such that the highlighted 
solid face becomes non-planar. 

3. The reference element, Plane.1 will 
be affected and the design becomes 
unstable.

In the example shown, reference element 
Plane.1 is offset from the highlighted solid 
face.

1

3

2

Plane.1
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No Reference Elements on Solid Face (3/3)

1. Line.1 relies on a dress-up feature. 
2. Because of a downstream 

manufacturing process, the dress-up 
features are deactivated.

3. The reference element, Line.1 will 
be affected and the design becomes 
unstable.

In the example shown, reference element 
Line.1 is parallel to edge of fillet.

1

2

3

Line.1
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Create Shaft and Groove Features
In this section, you will learn how to create revolved features that add and remove 
material.

Use the following steps:

1. Create feature profiles and 
Axis system. 

2. Create Multi-profile Sketch 
Feature

3. Create wireframe geometry.
4. Create shaft and groove 

features.
5. Shell the model.
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Creating an Axis

1

2 3

4

An axis can be used as a reference to create 
revolved features, such as shafts and grooves 
(discussed later in this lesson). The sketched 
profile is revolved about it. 

An axis can also be used to create symmetrical 
sketched elements inside the Sketcher 
workbench.

Use the following steps to create an axis:
1. Click the Axis icon.
2. Click to create the start point for the axis.
3. Click again to create the endpoint.
4. Using the shaft command on the profile 

sketch, CATIA produces a shaft using the 
defined axis.
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Dimensioning to an Axis

1

2

3

45

You can define diameter and radius 
dimensions to an axis. This is useful while 
creating the profile sketches for revolved 
features (discussed later in this lesson). 
Use the following steps to create a 
Radius/Diameter dimension to an axis:

1. Click the Constraint icon.
2. Select the sketched element.
3. Select the axis.
4. Right-click and select Radius/Diameter.
5. Click to place the dimension.
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Revolved Features (1/2)

A

B

A revolved feature is created by revolving a 2D 
profile around an axis of revolution. 

In the Part Design workbench, you can create 
two types of revolved features:

A. A shaft, which adds material.
B. A groove, which removes material.
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Revolved Features (2/2)

Profile

A

B

Revolved features can be revolved between 0°
and 360°. 

You can define the following limits:
A. The First angle limit defines the revolution 

angle of the profile around the axis, starting 
from the profile position and orientated in 
the clockwise direction.

B. The Second angle limit defines the 
revolution angle of the profile around the 
axis, starting from the profile position and 
oriented in the counterclockwise direction.
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Axis of Revolution

The axis of revolution for a revolved feature can 
be defined by two methods. The axis can be 
created inside the actual sketch containing the 
profile, using the Axis tool. If the axis is created 
inside the sketch, it will be detected 
automatically while defining the shaft or groove. 

If you did not create an axis in the sketch, or 
want to use a different axis other than the one 
defined in the sketch, you can define it from the 
Shaft/Groove definition window in the Axis 
selection field. Any linear element in the model 
(e.g., an edge of existing geometry, a 3D 
wireframe line, a line created in a sketch) can 
be used.
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Shafts
2

1
3

5

4

6

A shaft is a revolved sketched-based feature 
that adds material to the model. 

Use the following steps to create a shaft:

1. Select the profile.
2. Click the Shaft icon.
3. If no axis is created inside the sketch, 

select an axis of revolution.
4. Define angle limits.
5. Click OK to complete the feature.
6. The shaft feature is added to the model.
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Creating Grooves

1

3

2

4

5
6

Grooves are revolved features that remove 
material from existing features by rotating a 2D 
profile around an axis. The axis and the profile 
can be created in the same sketch or the axis 
can reside outside of the sketch. 

Use the following steps to create a Groove 
feature:

1. Select the Profile.
2. Click the Groove icon.
3. If no axis is created inside the profile 

sketch, select an axis of revolution. In this 
example, the implicit axis of the cylindrical 
feature is selected.

4. Define angle limits.
5. Click OK to complete the feature.
6. The Groove feature is added to the model.
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Restrictions for Revolved Features (1/2)

Not every sketch can be used to create a shaft base feature. The examples shown 
display various sketch solutions:

Axis on a profile edge:

Axis outside the profile:

Axis cutting the profile:

Error
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Restrictions for Revolved Features (2/2)

Not every sketch can be used to create a shaft 
base feature. Below are some examples 
showing various sketch solutions (continued):

Open profile:

Open profile and axis outside the profile:

Error
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Exercise: Shaft and Groove
Recap Exercise

15 min

In this exercise you will create a new tool holder part by creating a 
revolved feature using a point, line, and sketch. A reference plane will 
then be used to create an additional feature.

By the end of this exercise you will be able to:

� Create reference geometry

� Create a shaft feature

� Create a groove feature

� Use reference geometry to create new features
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Do it Yourself (1/10) 

2a

2d

2c

2b

1e

1d1. Create a new part. 
� Create a new part file.

a. Click File > New.
b. Select Part from the list of document 

types.
c. Click OK.
d. Leave the default name, clear the 

Enable hybrid design option.
e. Click OK.

2. Create a point.
� Create a point by specifying coordinates. 

This point will be used as a reference to 
create a line The line is then used as the 
axis of revolution for a shaft feature.

a. Click the Point icon. If you can’t find 
the icon, specify [c:point] in the power 
input line.

b. Change the point type to Coordinates.
c. Type [–4] for the Y value and leave all 

other inputs as default.
d. Click OK to create the point.
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Do it Yourself (2/10) 

3f

3e

3d

3c

3b

3a

3. Create a line.
� Create a line in the Z axis direction using 

the created point.
a. Click the Line icon. If you cannot find 

the icon, specify [c:line] in the power 
input line.

b. Change the Line type to Point-
Direction.

c. Select the Point.1 that was created 
previously.

d. Right-click on Direction and click Z Axis.
e. Select the Infinite End Point option for 

the Length Type.
f. Click OK to complete the line.
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Do it Yourself (3/10) 

4d

4e

4a

4b
4. Create a sketch.

� Create a sketch that will represent the 
profile for a tool holder. 

a. Right-click on the PartBody and select 
Define in Work Object. This ensures 
that features that are created are added 
to the PartBody and not the Geometrical 
Set.

b. Click the Sketcher icon.
c. Select the YZ plane as the sketch 

support.
d. Use the Profile icon in sketcher to create 

the lines.
e. Create an axis vertically along the V axis.
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Do it Yourself (4/10) 

4j

4g

4i

4h

4f

4. Create a sketch (continued).

f. Click the Constraint icon. 
g. Select the top vertical line.
h. Select the axis. Right-click and select 

Radius/ Diameter from the contextual 
menu. 

i. Click to place the diameter dimension.
j. Finish dimensioning and constraining 

the sketch as shown. Ensure that the 
left edge of the sketch is aligned to 
the V axis.
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Do it Yourself (5/10) 

5e

5b

5c

5d

5a

5c

5. Create a shaft feature. 
� Create a revolved feature using the 

sketch and line created previously.
a. Click the Shaft icon.
b. Select Sketch.1 previously created as 

the profile selection.
c. Click on the Axis Selection field and 

select Line.1.
d. Make sure the first angle is [360deg] 

and the second angle is [0deg].
e. Click OK to complete the shaft.
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Do it Yourself (6/10) 

6c

6d 6d6c

6. Create a groove feature.
� Create a sketch that will be used as the 

profile for a groove on the tool holder.
a. Click the Sketcher icon.
b. Select YZ plane as the sketch support.
c. Use the Project Silhouette Edges tool 

to project the side surface of the shaft. 
d. Select both projected edges and 

convert them to construction entities.
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Do it Yourself (7/10) 

6g

6i

6h

6e

6. Create a groove feature (continued).

e. Sketch and dimension a square as shown.
f. Exit the sketch.
g. Click the Groove icon.
h. Select Sketch.2 as the profile and Line.1 

as the axis.
i. Click OK to complete the groove.
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Do it Yourself (8/10) 

7e

7d

7b

7a

7. Create a reference plane.
� Create an offset reference plane that will be 

used as the sketch support for a new sketch.
a. Click the Plane icon. If you cannot find the 

icon, type [c:plane] in the power input line.
b. Select Offset from plane as the Plane 

type.
c. Select the YZ plane as the reference plane.
d. Specify [60mm] as the offset.
e. Click OK to complete the plane.
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Do it Yourself (9/10) 

8c

8. Create two pocket features.
� Create two pocket features using Plane.1 as 

the sketch support.
a. Click the Sketcher icon.
b. Select the Plane.1 as the sketch support.
c. Sketch and constrain a rectangle as shown.
d. Exit the Sketcher workbench.
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Do it Yourself (10/10) 

8j

8i

8h

8g

8. Create two pocket features (Continued).

e. Click the Pocket icon.
f. Select the sketch just created as the profile.
g. Specify [16mm] as the pocket depth.
h. Click OK to complete the pocket.
i. Create another pocket with the same Sketch. 

Specify the First Limit Depth as [104mm] and 
the Second Limit as [-114mm] for the second 
pocket.

j. Click OK to complete the second pocket. 

9. Save and close the part.

Conf. Dep.
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Exercise Recap: Shaft and Groove

� Create a reference point and line

� Create a shaft feature

� Create a groove feature

� Create a reference plane

� Create features on reference plane
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Exercise: Shaft and Groove
Recap Exercise

15 min

In this exercise you will create a new part. Using the shafts, grooves, and multi-pocket 
features, you will construct a pulley. High-level instructions for this exercise are 
provided.

By the end of this exercise you will be able to:

� Create a shaft

� Create a groove

� Create a multi-pad
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Do it Yourself (1/3) 

2

1. Create a new part file.
� Create a new part file called 

[Ex4E.CATPart].

2. Create a shaft feature.
� Use the dimension shown to construct a 

shaft feature.
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Do it Yourself (2/3) 

3. Create a groove feature.
� Use the dimensions shown to create a groove feature. 

Remember to use the transformation tools while creating 
several identical profiles within one sketch. All profiles have 
the same internal dimensions.
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Do it Yourself (3/3) 

4

4. Create a multi-pocket feature.
� Use the dimensions shown to create a 

multi-pocket feature.

5. Save and close the model.
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Exercise Recap: Shaft and Groove

� Create a shaft feature

� Create a groove feature

� Create a multi-pocket feature
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Exercise: Shaft and Groove
Recap Exercise

15 min

In this exercise, you will create a part that contains features taught in 
this and the previous lessons. You will use the tools learned in this 
lesson to complete the exercise with no detailed instructions. 

By the end of this exercise you will be able to:

� Create a shaft feature

� Create edge fillets

� Create internal and external groove features 

� Create a pocket feature

� Create a reference point and line

� Create a cone-shaped groove feature
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Do it Yourself

1. Create the following spool part.



Student Notes:

CATIA V5 Fundamentals- Lesson 4: Additional Part Features
����������	��

Copyright DASSAULT SYSTEMES 4-126

C
op

yr
ig

ht
 D

A
S

S
A

U
LT

 S
Y

S
TE

M
E

S

Exercise Recap: Shaft and Groove

� Create a shaft feature

� Create edge fillets

� Create internal and external groove features 

� Create a pocket feature

� Create a reference point and line

� Create a cone-shaped groove feature
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1. Create feature profiles and 
Axis system. 

2. Create Multi-profile Sketch 
Feature

3. Create wireframe geometry.
4. Create shaft and groove 

features.
5. Shell the model.

Shell the Model
In this section, you will learn how to create hollow models using the Shell operation.

Use the following steps:
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Shelling

Shell

Faces to be removed

Shelling a feature hollows out solid geometry. The shelling operation removes one or 
more faces from the solid and applies a constant thickness to the remaining faces. 
You can also apply a different thickness to the selected faces.
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Shelling a Part (1/2)

1

2

3

4

5

Use the following steps to shell a model where 
the remaining faces have a different thickness:

1. Select the face(s) to be removed.
2. Click the Shell icon.
3. Specify a wall thickness.
4. Select on the Other Thickness Faces 

field.
5. Select the wall(s) that will have a different 

thickness.
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Shelling a Part (2/2)
6

7

8

9

Use the following steps to shell a model where 
the remaining faces have a different thickness 
(continued):

6. To change the thickness of the Other 
Thickness faces, double-click the 
dimension directly on the model, and 
specify the value. Take care to select the 
dimension associated with the correct 
direction.

7. Click OK to the Parameter definition 
dialog box.

8. Click OK to the Shell Definition dialog 
box.

9. The shell feature is added to the model.
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Recommendations for Shelling
In this section, you will be given a recommendation to help during the creation of shell.
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Avoid Shell with Multiple Thickness 

1

1. The part is large and the shell 
thickness values are relatively small.

2. If the bottom face is assigned another 
thickness value, it is not possible to 
distinguish it unless the hidden lines 
are displayed or the distance is 
measured.

It is recommended that you avoid using 
shells having multiple thickness value.

It is not easy to visually distinguish the shell 
thickness values if:

2
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Importance of Feature Order

While shelling a model, it is important to  
consider the feature order. The Shell operation 
hollows all solid features in a model. If you do 
not want a feature to be shelled, it must be 
created after the shell operation.

For example, when a feature containing a hole 
is shelled, a pipe is created. If the design intent 
requires a hole, the shell feature needs to be 
created before the hole.
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Thin Features (1/2)

A thin feature is created by applying a 
constant thickness to a profile. Pads, 
pockets, shafts, and grooves can all be 
created as a thin feature. Use the Pad 
Definition dialog box to define its properties:

• A thin feature can be created with a 
closed or open profile. 

• Thickness can be applied to one side or 
both sides of the profile.

Conf. Dep.
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Thin Features (2/2)

1

2

3

4

5

The definition dialog boxes for pads, pockets, 
shafts, and grooves contain a section for 
defining a thin feature. Use the following steps 
to create a thin pad:

1. Select the Thick option.
2. The dialog box expands to display 

additional options.
3. Specify the thickness values. Thickness 1 

defines the inside thickness, and Thickness 
2 defines the outside thickness. 

4. Click OK to complete the feature.
5. The feature is added to the model.

Conf. Dep.
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In the following slides you will find a summary of the topics covered in this lesson.

To Sum Up
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Lesson 2 introduced you to the basic Sketcher 
tools and the Sketcher environment. This lesson 
will introduce you to the advanced Sketcher tools.
Sketcher includes the following additional tools:

� Re-limitation tools
� Transformation tools
� Project 3D element tool
� Analyze a sketch using the Sketch Analysis tool.

Multi-pads and pockets are features that create 
several pads/pockets in one operation. These tools 
require a sketch with at least two closed profiles. 
Consider using these tools as a fast way to create 
multiple features

Careful thought must be given to the profiles 
created in the sketch when they are used to define 
a Multi-Pad/Pocket. The profiles cannot intersect, 
they must form a closed loop to avoid feature 
definition error. 

Create Multi-profile Sketch Feature

Create Feature Profiles and Axis System 
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In the Part Design workbench, you have the ability 
to create points, lines, and planes outside of the 
Sketcher environment. These elements are called 
reference or 3D wireframe geometry.
Depending on how the part was initially created, 
these elements can be represented in the 
specification tree in two ways. If the Enable hybrid 
design option is selected, CATIA will place these 
features within the main PartBody. If the Enable 
hybrid design option is cleared, wireframe elements 
are inserted under a group called a Geometrical set. 
Geometrical sets contain only 3D wireframe and 
surface elements and not solid geometry.

Create Shaft and Groove Features
A revolved feature is created by revolving a 2D 
profile around an axis of revolution. In the Part 
Design workbench, you can create two types of 
revolved features:

The axis of revolution for a revolved feature 
can be created inside the sketch containing the 
profile, using the Axis tool. 
If you did not create an axis in the sketch you 
can define it from the Shaft/Groove definition 
window in the Axis selection field. Any linear 
element in the model can be used.

Create Basic Wireframe Geometry
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Shelling a feature hollows out solid geometry. The 
shelling operation removes one or more faces from 
the solid and applies a constant thickness to the 
remaining faces. You can also apply a different 
thickness to the selected faces.

While shelling a model, it is important to consider 
the feature order. The Shell operation hollows all 
solid features in a model. If you do not want a 
feature to be shelled, it must be created after the 
shell operation. 

Create Thin Features 

A thin feature is created by applying a constant 
thickness to a profile. The definition dialog 
boxes for pads, pockets, shafts, and grooves 
contain a section for defining a thin feature. 

� A thin feature can be created with a closed 
or open profile. 

� Thickness can be applied to one side or 
both sides of the profile.

Shell the Model
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1

2

3

Knowledge

Formula: creates Relationships between 
Dimensions

Equivalent dimensions: Equates all selected 
parameters to a value 

5

Relimitations: trim or extend the existing 
sketched geometry

Transformation: modify existing sketcher 
geometry

3D Geometry: project the existing 3D elements 
onto the sketch plane

Operation 

4

Tools 

Sketch Analysis: helps to resolve problems with a sketch

6

7

Tools

Axis System: used to define local coordinates

1

2

3

4

5

6

7

Additional Sketcher Tools
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1

2

4

5

6

3

7

1

2

Sketch-Based Features

4

3

Reference Elements 

5

Point: creates a point in 3D space 

Line: creates a line in 3D space 

Plane: creates a plane in 3D space 

Multi-pad: creates several pads in one operation

Multi-pocket: creates several pockets in one 
operation 

Shaft: helps to resolve problems with the sketch6

Dress-Up Features

7 Shell: removes one or more faces from the 
solid and applies a constant thickness to the 
remaining faces

Additional Part Design Tools
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Exercise: Thin Pad and Shell
Recap Exercise

15 min

In this exercise you will create a happy face stamp from a new part. You 
will use the tools learned in this lesson to create a pad, a fillet, shell and 
thin feature. Detailed instructions for this exercise are provided.

By the end of this exercise you will be able to:

� Create a shell feature

� Create a thin pad
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Do it Yourself (1/6) 

2f

2c

1d

1. Create a new part. 
� Create a new part file.

a. Click File > New.
b. Select Part from the list of document 

types.
c. Click OK.
d. Accept the default name and click 

OK.

2. Create a sketch.
� Create a square profile.

a. Click the Sketch icon.
b. Select the XY plane to place the 

sketch.
c. Click the Rectangle icon and sketch 

an approximate square as shown.
d. Dimension the square to [100mm] as 

shown.
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Do it Yourself (2/6) 
3b

3c

3d

3. Create a pad.
� Create a pad from the sketch.

a. Select Sketch.1.
b. Click the Pad icon.
c. Specify [50mm] as the pad length.
d. Click OK to complete the feature.
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Do it Yourself (3/6) 

4b

4a

4c

4. Create an edge fillet.
� Create an edge fillet on all the edges of 

the pad except for the bottom surface 
edges.

a. Click the Edge Fillet icon.
b. Select the top surface of the pad and 

the four vertical edges.
c. Specify [5mm] as the radius.
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Do it Yourself (4/6) 
5a

5c

5d

5b

5. Create a shell feature.
� The filleted pad will be shelled by 

removing the bottom surface and 
specifying a thickness to the rest of the 
surfaces.

a. Click the Shell icon.
b. Select the bottom surface of the 

filleted pad.
c. Specify [10mm] as the Default inside 

thickness.
d. Click OK to complete the shell.
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Do it Yourself (5/6) 

6d

6b

6. Create a happy face sketch.
� Create a sketch on the top surface of 

the pad with circles and arcs that 
resemble a happy face.

a. Click the Sketch icon.
b. Select the top surface of the pad as 

the sketch support.
c. Sketch three circles and an arc to 

resemble a happy face.
d. Dimension the sketch as shown.
e. Exit the sketcher.



Student Notes:

CATIA V5 Fundamentals- Lesson 4: Additional Part Features
����������	��

Copyright DASSAULT SYSTEMES 4-148

C
op

yr
ig

ht
 D

A
S

S
A

U
LT

 S
Y

S
TE

M
E

S

Do it Yourself (6/6) 

7c

4l
7e

7d

7f

7a
7. Create a thin pad.

� Use the happy face sketch created in the 
previous step to create a thin pad.

a. Click the Pad icon.
b. Select the happy face sketch from the 

specification tree.
c. A feature definition error dialog box 

appears. Click Yes to continue.
d. When the Pad Definition dialog box 

opens, select the Thick option. The 
dialog box expands.

e. Specify [3mm] for Thickness1, 
[1mm] for Thickness2, and [10mm] for 
the Length.

f. Click OK to complete the pad.

8. Save and close the model.

Conf. Dep.
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Exercise Recap: Thin Pad and Shell

� Create a shell feature

� Create a thin pad
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Exercise: Pad, Fillet, Hole and Shell
Recap Exercise

20 min

By the end of this exercise you will be able to:

� Create a pad

� Create an edge fillet

� Create holes

� Create a shell feature

In this exercise you will open an existing part that contains a sketch. You will use this 
sketch to create a pad, fillet, and shell feature. High-level instructions for this exercise 
are provided.
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Do it Yourself (1/4) 

2

1
1. Open up the part Ex4H.CATPart.

� Open an existing part file using the Open 
tool. The part file contains a sketch.

2. Create a pad.
� Create a pad with a length of [175mm] 

using the existing sketch.
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Do it Yourself (2/4) 

3

3. Create edge fillets.
� Create an edge fillet feature. Select the 

top surface and all the six vertical 
edges.
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Do it Yourself (3/4) 

4

4. Create holes.
� Create [50mm] diameter holes. Use the top 

of the pad as the starting surface and make 
them concentric to the two center radii. Set 
the depth to cut through the entire pad.

Conf. Dep.
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Do it Yourself (4/4) 

5

5. Create a shell feature.
� Create a Shell and select the bottom surface 

to be removed and specify a thickness of 
[5mm] for the inside thickness.
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Exercise Recap: Pad, Fillet, Hole and Shell

� Create a pad

� Create a fillet

� Create holes

� Create a shell feature
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Exercise: Thin Pad, Shell and Holes
Recap Exercise

10 min

By the end of this exercise you will be able to:

� Create pads

� Create a shell

� Create a thick pad

� Create holes

� Create a chamfer

In this exercise you will create a part that contains features taught in this and the previous 
lessons. You will use the tools learned in this lesson to complete the exercise with no 
detailed instructions. 
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Do it Yourself

Create the following part.
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Exercise Recap: Thin Pad, Shell and Holes

� Create pads

� Create a shell

� Create a thick pad

� Create holes

� Create a chamfer
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Case Study: Additional Part Features
Recap Exercise

20 min

In this exercise you will create the case study model. 
Recall the design intent of this model:

� The top portion and bottom portions of the model must be created as separate features.

� The holes must created at an angle to the XY plane.

� The model must be hollow.

� The holes must be drilled normal to the sides of the handle.

Using the techniques discussed so far, create the model without detailed instructions.
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Do It Yourself: Drawing of the Handle Block (1/4)

2

1

You will need to create the following features:

1. Create a multi-pad feature.
� Create the bottom section of the model 

with the Multi-pad tool.

2. Create a revolve feature.
� Create the top section of the model 

using a revolve feature.
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Do It Yourself: Drawing of the Handle Block (2/4)

3

4

5

You will need to create the following features 
(continued):

3. Create a groove.
� Create a cut using the Groove tool. Use the 

Project 3D tools to associate the cut to the 
revolve feature.

4. Create a plane.
� Create a plane [45] degrees from the XY plane.

5. Create holes.
� Create holes that are coincident with the user-

defined plane.
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Do It Yourself: Drawing of the Handle Block (3/4)

6
8

8

8

You will need to create the following features
(continued):

6. Create a pocket.
� Create the sketch for the pocket by 

creating one profile, use the Rotate tool to 
create the remaining three profiles.

7. Shell the model.
� Shell the model to a thickness of 2mm, 

except at the bottom where the thickness 
should be different (see the drawing).

8. Create dress-up features.
� Complete the model by adding a 5mm fillet 

to the top edge and a 1mm x 45 degree 
chamfer to the two edges shown.
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Do It Yourself: Drawing of the Handle Block (4/4)

Use the dimensions shown to complete the Handle Block part.
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Case Study: Handle Block Recap

� Create a multi-pad feature

� Create a shaft feature

� Create a groove feature

� Create reference geometry

� Create holes

� Create a pocket

� Shell the model

� Create dress-up features


